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1 Tagging Video
Traditionally, reviewing sporting performance on video is a linear process – you rewind the
tape, press play and observe the action as it takes place. Of course your camcorder's fast
forward button saves time but finding and replaying important moments in the game or
competition essentially remains linear – and slow.

Imagine how useful it would be to be able to mark and label these events on the tape as you
are filming because you could later jump between these marks in any order you choose. You
could review only the events of interest and choose to see related events:  "Let me look at all
the times our opposition scored" ceases to be a lengthy process of fast forward and play.

Dartfish's Tagging module doesn't physically mark a tape but instead brings digital video onto
the computer and allows you to create a searchable index of the video content. Each event is
tagged with not just one label but a set of values that really identify what is happening. This
process not only lets you search and review these events but compiles match statistics:  "Which
shot does my opponent most often score with?" is not only a question that can be easily
answered, but the relevant shots can be replayed and analyzed.

A short history of tagging

If all this sounds familiar, that is because Dartfish Tagging is a combination of long-used
tactical analysis methods:

Notational analysis - the coach or analyst sits on the sideline with pen & paper ticking off or
coding events as they take place in a game. Tagging does this using buttons which are clicked
to code events.

 Video indexing - even before digital video, coaches attempted to make it easier to find useful
moments in the video of the game by noting the time that they took place. This made it easier
to fast forward to that point on the tape but it's easier still with Tagging; the events you code
are listed in an index which can be searched and displayed non-sequentially.

Is Tagging just for Team sports?

No. While other Dartfish modules are used for technical analysis of isolated events. Tagging is
more about a tactical analysis of the game as a whole while being able to focus on specific
moments of choice. It is therefore useful for any sport where these qualities are of interest:
Team sports, racket sports, combat sports, skating/gymnastic routines etc.
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1.1 What is Tagging?

Tagging is the action of creating a video index, a list of Events that occur in the video. Consider
for example a video that contains a soccer game; the video index could look like this:

Index Position Duration Event Type Player Team

Event #1 23 s 7 s Pass Defender Team A

Event #2 1 min 13s 7 s Free kick Striker Team B

... ... ... ... ...

The Position corresponds to the time in the video when the event occurred.

The Duration is a portion of the video when the events take place.

Event type, Pass and Team are Categories. Pass, Defender and Team A are the Values in
each category.

An event is fully defined by the Position, Duration and the categories' Values. It can be
illustrated as follows:

Once you have created your index, you will be able to retrieve particular events. For example,
you may want to retrieve events that match the following criteria:

Team = Team A, i.e. all events of Team A

Event Type = Pass and Team = Team A, i.e. all the passes of Team A

It is important to be aware that the Tagging module doesn't just tag instantaneous events such
as these examples, lengthy sections of video such as a team's ball possession can be tagged at
the same time as the passes and free-kicks taking place during that possession.

1.2 The Tagging Workspace

To launch the Tagging module, click on the Tagging icon in the icon bar, or select Tools >
Tagging from the menu bar.

The module workspace is illustrated below:
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It is composed of four different elements (from left to right, top to bottom):

1. The Library (more precisely the Tray of the library), which opens a collection of video clips
to be tagged or reviewed.

2. The Video Panel, which contains the video display and the different video controls which let
you capture and replay video. This also has controls to display and hide the other panels
and select the video source.

3. The Tagging Project Panel, which has a Create Events function to tag new events and a
Search Events function to calculate event statistics and filter the Events list for specific sets
of events.

4. The Events List, which contains the list of events, i.e. your video index

These elements are described in more detail in the following remainder of this section.

When you launch the Tagging module for the first time, the workspace may not look like the
one illustrated above. If any of the four elements are not visible they may be displayed by
using the Views Bar buttons (see The Video Panel) at the top right corner of the video panel.

1.2.1 The Library

The Tray of the library (read the Video Library chapter to learn more) contains the video clips
that are currently being used with the Tagging module. This means that:

The events of all clips contained in the Tray are displayed in the Events list e.g. the events
of a whole year's competition can be analyzed together.

A search can be used to retrieve events that are contained in all video clips within the Tray.

The highlighted video clip is the one currently being played or tagged.
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1.2.2 The Video Panel

The Video panel is illustrated below.

The two top bars are explained below (the other functions are explained in other sections and
referenced in the text below):

Mode bar

The Mode Bar enables you to choose between two tagging modes and a video player mode.

Use the Tag Live mode to capture video to your hard disk. You have the possibility to tag
during capture. The screen and the different settings are similar to the ones of the DV
Import module (see Capturing from camera in the Video Library chapter)

In the Tag Video Clip mode you can tag video clips that exist on your hard disk.

The Play Events mode allows you to play back the entire video clip or selected events from
the Events list.

These last two modes use the screen and control buttons illustrated above. Read the section
Video Playback of the Getting familiar with Dartfish chapter to learn about the different
controls.

Views bar
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Use the Views bar buttons to show/hide the different panes of the Tagging module. The
buttons' functionalities are:

 show/hide Create Events pane

 show/hide the Events list

 show/hide Search Events pane

 show/hide Library pane

1.2.3 The Tagging Project Panel

The Tagging Project Panel has two views selected from tabs at the bottom (or from the Views
bar, see The Video Panel)

 Create Events is used to access and create Tagging Panels. You can open existing
templates or create new templates to meet your specific needs (see Creating Tagging
Panels).

Search Events is used to access and create Search Events Tables. You can use it to retrieve
specific events, e.g. all the scoring free kicks (see Search to retrieve specific events).

1.2.4 The Events List

The Events List contains the list of all events for all video clips in the current Tray:

Events are selected by clicking on the row containing them. Double-clicking an event plays it.

Selected events may also be:
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Deleted using the Delete button.

Analyzed in Dartfish's Analyzer module (Storyboard button).

Exported as .csv files using the Import/Export button.

Published as new video clips that can be stored on your hard drive (e.g. to be imported in a
video editing software) or directly burned on a CD (e.g. to give to team players or
coaches), using the Publish Events button.

Sorted by clicking on the column heading you wish to sort.

1.3 Creating Tagging panels

To create your own tagging panels you will need to decide:

Which events do you want to tag in your sport?

Which of these events have a fixed duration (e.g. actions) and which are of variable
duration (e.g. game phases).

How will you describe these events?  Events are described by assigning values to them.

Example of a Tagging Panel:
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1.3.1 Creating/Editing Tagging panels

To create a new tagging panel, proceed as follows:

1. Click on the Select button and choose New from the context menu.

2. Click on the link Create a New Tagging Project

3. Create a new Blank Project if you wish to start with an empty panel OR base a new panel
on one of the built-in tagging panels.

To edit a Tagging Panel

Click on the Edit button.

This displays the Tagging Editor window.

We recommend starting by using one of the Dartfish built-in tagging panels. Change labels
and add/delete buttons as necessary for your sport.

1.3.2 Toolbox

The Toolbox contains all the tools needed to create tagging panels. These can be divided into 4
types:

1. Event tools – create new events and add them to the Events List.

2. Value tools – add additional values to events already created but do not create new
events.

3. Layout Container tools – these group buttons together to control their position on the
tagging panel.

4. Team Management - is used to manage teams and players.
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1.3.2.1 Adding/deleting an item

Items from the Toolbox are placed onto the tagging editor by drag and drop.

To move an item

Drag and drop the item you want to move to the new position.

You can only move an item to the bottom or to the far right of a Layout Container.

To move a Layout container, click and drag the dotted lines at the top of the container.

To delete an item

Right-click on the item and select Delete from the context menu.

1.3.2.2 Event Buttons

Events Buttons are used to add events to the Events List. There are two events tools to do this:

The Event button is used to create events with a fixed duration e.g. a tennis serve will
always take around 5 seconds to prepare and deliver and witness the outcome. A single
click on this type of event button records the event.
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The Continuous Event button creates events where the duration is not known in advance,
e.g. a whole point in a tennis game or an attacking phase in soccer. This button is clicked
"on" and "off" as the event starts and ends.

1.3.2.3 Value Tools

Value Buttons

Value Buttons are used to add values to describe an event. For example, who is doing the
action, where are they doing it and how are they doing it?

The Value button assigns a value to the last tagged event (or to the selected event in the
Events List).

The Persistent Value button applies its value to all events which are tagged while it is
switched on ("pressed").

Text box

The text box tool is a special persistent value tool that lets you assign a variable value to any
event created. For example you might use this to include the name and date of the competition
or information about the conditions, as illustrated below:
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Score panel

The score panel is another persistent value tool that lets you specify the current score of the
game.

1.3.2.4 Layout Containers

Two types of Layout Container, the Group Box and the Tab Group Box, can be used to organize
the tagging panel.

All tools in a group box belong to the same category, i.e. tools inherit from the category of
the Group Box (or Tab Group Box) into which they are contained.

Layout containers are also used to activate/deactivate (switch "on" and "off") Continuous
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Event and Persistent Value buttons contained in the same Group Box or Tab Group Box. For
example, if continuous event buttons used to indicate attacking or defensive play have the
category 'Game Phase'. When the attacking button is activated, the defensive button will be
deactivated.

1.3.2.5 Team Manager & Team Group Box

The Team Manager tool is used to display value buttons representing players. If you have a
large squad or several different teams to choose from, you will use the Team Manager to store
all teams and player names but only buttons for players taking part will be displayed during
tagging. The Team Manager tool must be linked  to a Team Group Box tool which will display
the buttons (see Linking Team Manager and Team Group Box).

 During tagging you will not have to regularly have to access the team manager control. It is
better to put the team manager on a separate Tab Group Box and the Team Group Box on a
tab with other event and value tools that you will use together with the player buttons.

Team Manager databases

The information you add to a Team Manager tool is stored in a database file which is created
automatically for you. However, you may want to share this information with other Dartfish
users. You can find the location of the database being used or select another database by using
the Database Editor tab of the tagging panel editor.

1.3.3 Tagging Panel Properties

Having added event and value tools to the tagging panel,  each has 3 crucial properties
which you must set as you create or edit a tagging panel:

1. Label – the text that identifies what this tool does.

2. Value – the value that will be assigned to the event.

The label on a button will often be the same as the value it assigns. When this is the
case, only set a label property and leave the value property blank. The label text will be
assigned as a value to events.

3. Category – the category to which the value will be assigned. Think of the category as being
the column heading of the Events List (see The Events List) in which values will appear.

The other properties are explained in section Properties list.
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1.3.3.1 Modifying properties

Items which have been added to the Tagging Editor can have their appearance and function
modified by changing properties in the Properties panel. There are two types of properties;
properties which can take any value and properties which must take one or more fixed values.
The methods for modifying these two types of property are described below:

Modifying 'any' value properties.

1. Click on the item. This will display the properties panel for that item.

2. Click and type in the second column of the properties list to add or modify values.

Modifying 'fixed' value properties.

1. Click on the item. This will display the properties panel for that item.

2. Clicking in the second column of the properties list will allow you to select a value using the
buttons that appear. It is not possible to type values. One of two types of button are used:

 - selects or creates property values from a dialog box e.g. shortcut key property

 - selects property values from a drop down list e.g. style property

In the example shown below these buttons are shown as they would appear in the properties

panel. Properties such as Shortcut Key, Preroll and Trigger are selected using . Properties

such as Style are selected using , and properties such as Category, Value and Label are
typed.

Double clicking the property heading is a shortcut to editing fixed value properties.

1.3.3.2 Properties list

By clicking on any element on the tagging panel workspace, its properties are displayed in the
Properties pane. The properties of each tagging panel element are used to alter their
appearance and behavior. Each type of item has its own range of properties but the most
common are described here:
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Properties which alter appearance:

Property What it does… Applies to…

Label Changes the text that is displayed on the item All

Tooltip The tooltip is the explanatory text that appears when the
mouse cursor is pointed at a button. Use this to explain the
function of each button.

All event and
value tools

Shortcut Key Rather than clicking buttons on a tagging panel, using the
keyboard Shortcut Key property for event or value buttons can
be much more efficient. Note that these shortcuts are
displayed in parentheses in each button

All event and
value tools

Image An image can be displayed on a button to help identify the
event or value that it represents

All Buttons

Style The style property can be used to help distinguish items
visually

All Buttons

Properties which affect behavior:
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Category A category represents a set of values which will be used to
identify different events in a video clip.
Each tagging panel element gets its category property from
the Layout Container in which it is placed. It is therefore
quicker to place buttons with the same category inside a tab or
group box and set the category property of the container.
Setting the category property for an item overrides the
category set for any containers in which it is placed.

All

Value Values are used to identify each event tagged in a video clip.
e.g. Squash might have each stroke event tagged with values
for the stroke type, the player who played it and where in the
court it was played.

All Buttons,
text box

Preroll the amount of video before an event button is clicked that will
be included in the event. Preroll ensures that you don't miss
the start of the action.

Event
Buttons,
Team Group
box

Duration Duration is the duration of the event that will be tagged when
this button is clicked. This time includes any preroll that has
been set. If the event is not of fixed duration then a continuous
event button should be used to manually mark the beginning
and end of an event.

Event
Buttons

Offset Start Offset Start - the amount of video before or after  a continuous
event button being clicked on that will be included in the
event. This ensures that you don't miss the start of the action.
Can be a positive or negative value.

Continuous
Event
Buttons

Offset End Offset End – the amount of video before or after a continuous
event button being clicked off that will be excluded at the end
of an event. This ensures that irrelevant footage is not included
in the event.

Continuous
Event
Buttons

Reset Category Tools with a reset category property can be used to deactivate
other continuous event or persistent value tools. When this
tool is clicked, all other buttons using the category specified
are reset.

All buttons

Trigger The trigger property is a list of one or more tools that can be
activated when this button is clicked.

All buttons

Target Defines what the value typed into a text box will be used for.
Can be used to define a file name, a category for exported
events or a category for the event list.

Text box

Team Used to link a Team Group Box to a Team Manager tool. By
making the team property the same as the Team Manager's
label property, the team group box will display players selected
from the Team Manager.

Team group
box

Clicking on a property title in the properties panel displays a description of that property.
Double clicking on the property title allows you to change that property.

1.3.3.3 Linking Team Manager and Team Group Box

The Team Manager tool must be linked to a Team Group Box tool which will display the
buttons. To do this, proceed as follows:

1. In the Tagging Editor window, add a Team Manager tool and Team Group Box tool to your
tagging panel. Remember to enter a Label property for the Team Manger and category
property for the Team Group Box e.g. 'home players'.

2. Link these two items by modifying the Team property of the Team Group Box. This is done
as shown in the image below (1) Double click the heading 'Team' and then (2) Tick the
Team Selector to be linked.
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3. Save your changes and close the Tagging Editor window.

Do player buttons add values or events?

The player buttons are Value buttons by default. However, you may want to make player
possession a continuous value if several events will take place while a player has possession. Or
you may want to make player possession an event or continuous event if you want to replay
examples of a player's possession.

The choice of what type of buttons a player group box will contain is made by changing its
Button Type property in the tagging panel editor.

To use the Team Manager control during tagging, add teams and players, see Using the Team
Manager and Team Group Box.

1.3.3.4 Controlling the flow of Tagging

As you become more adept at tagging, you will possibly seek to tag a greater range of events
and so provide a more complete picture of the events that make up your sport. As your tagging
panels grow larger it is worth being aware of how you can control the flow of tagging such that
some of your tagging actions will automatically activate or deactivate other relevant tagging
panel items.

One example of this can be seen in some of the tagging panels provided by Dartfish. Clicking
an event button triggers a tabbed group box revealing value buttons associated with that
event.

Reset Category property

Tools with a reset category property can be used to deactivate other continuous event or
persistent value tools.

When this tool is clicked, all other buttons using the category specified are reset. In effect, this
behavior is similar to that described in the previous section but the tool with the reset category
property does not need to have an identical category property to the tool(s) that it will reset.
Also, this behavior is one directional – triggering buttons with any given category will not
deactivate those buttons with the same reset category.

For example: if player possession is being tagged, events such as 'shot on goal' should reset all
buttons with 'player' as a category as no player will have possession.



16 Dartfish User Guide

© Dartfish, all rights reserved. - Version 4.0 -

Be careful with spelling and use of spaces, the reset category you use must match the
category of the tools that you wish to reset. However the case used is unimportant.

Trigger property

Unlike the reset category property, the trigger property is used to both activate AND deactivate
other tools. It is also specific – rather than influencing all tools with a particular category
property, the tool(s) to be triggered are selected from a list of one or more tools that can be
activated when this button is clicked.

For example, when a scoring event is tagged the trigger property could be used to activate the
tab group box which contains a score tool.

1.3.4 Saving Tagging Panels

To save your tagging panel, select File>Save (or File>Save As...) from the menu bar of the
Tagging Editor panel.

1.4 Create events

In essence, the process is tagging is simple; you see an event, you click an event button then
you click value buttons.

Tagging can be applied in the following ways:

1. Tag Live - use this mode if you want to tag the action directly from a video camera, either
as it happens (record mode) or from tape (play back mode). In either case you will be
tagging and capturing video to your hard drive simultaneously.

2. Tag Video Clip - use this method if the video clip is stored on your hard disk. In this case,
your task is to playback the video clip, locate an event and tag.

3. Mixed tagging - you do always have time to fully define events as they happen, or you may
miss events. In this case, you are able to combine Tag live and Tag Video Clip by playing
back the video clip and editing/adding events after the game.

The result is a list of Events (displayed in the Events List, see The Events List) which can be
played individually or in sequence.

Events can also be "automatically" created by importing them from "comma separated value"
(csv) files created by other applications, e.g. statistical tools (see Importing events - automatic
tagging).

1.4.1 Tag Live mode

The process of tagging live is a simple one where you will start capturing video to disk and in
the process using a tagging panel to tag events. First activate the Tag Live mode (see The
Video Panel). Select a Capture Destination, a Capture Device and set the Clip Properties. Read
section Capturing from camera in the Video Library chapter to learn how to do this.

Tag live process:

1.  Click the Record button. The video clip starts being captured to your hard disk. The
live feed is displayed in the Video Panel. Use the tagging panel buttons to tag events as
they happen.

2.   Click Pause Recording (optional). You may wish to use this during parts of the
competition of no interest to you; half time, injury stoppage, gaps between competitors
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etc.

3.  Click Resume Recording (optional), to continue recording. Note that the
pause/resume recording does not create a new video clip.

4.  Click Stop Recording at the end of the game. A new clip is saved on your hard drive
and a thumbnail appears in the Tray.

It takes practice before you are able to accurately tag all events as they happen. Start
simply by tagging "important" events without adding too many additional values. Read the
section Review & edit events to see how you can edit and/or add events after they have taken
place.

If tagging from tape, the VCR button will display a set of controls allowing you to control your
video camera directly from Dartfish but remember that you must record video before starting
to tag.

1.4.2 Tag Video Clip mode

Tagging a video clip principally consists of four steps:

1. Loading a video clip and selecting Tag Video Clip mode.

2. Finding the relevant position on the video clip (see below).

3. Tagging an event in the video clip by clicking on an event button in the tagging panel.

4. Adding further values to that event by clicking on value buttons.

Finding the relevant position

There are many ways to find the position where game plays take place.

Drag the playhead to quickly position the video clip. Watch the time information next to
the playhead as you drag it. It can help you position the video if you approximately know
when a game took place.

Play/pause the video to fine-tune your selection (use the space bar to do this)

Use the speed control to fast-forward and/or fast-rewind the video. To do this, set the
speed to values greater than 1 (or -1 for fast-rewind) and play the video. Whenever you
see an event, either click on an event button or pause the video first, and then select the
appropriate buttons to tag the event.

You do not need to pause the video to change the playback speed.

Position the playhead to the previously tagged event and continue playing from there. In
section Review & edit events, you will see how to review an event. Simply click on the last
event in the Events list while in Play Events mode and switch back to Tag Video Clip mode.
The playhead remains at the position of the selected tagged event.
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1.4.3 Using the Team Manager and Team Group Box

Adding teams and players

Adding players and teams to the Team Manager is not completed in the tagging panel Editor
but after the tagging panel has been created and saved. Buttons at the bottom of the Team
Manager allow you to (left to right) add/remove teams and players from the team manager.

You may want to create more than one team if you tag several teams or squads but at least
one team must be created before adding players. After adding teams and players, their

properties (such as team/player name) may be altered by clicking the  button next to the
item to be edited.

Selecting players

Players are selected/deselected by 'ticking' the box next to their name. If the box is ticked, a
button representing the player will appear in the team group box linked to this player manager
control.

Philippe has been ticked, so…

… a button representing him appears in the team group box

1.4.4 Importing events

Many sports already use software which creates game statistics. TeamPro's Import Events
feature allows you to create automatically new events by synchronizing the statistics and the
video. The statistics have to be contained in text or comma separated value (csv) files.

When you import statistics you need to provide Dartfish with 2 pieces of information:

1. What are the delimiters?  These are the character which denote separations between
columns of data. e.g. a new column will start each time a comma is found in the imported
file.

2. Which imported columns correspond to the position and duration of game plays?  The
position is likely to correspond to the "stadium clock".

If your statistics do not include a duration column, you can manually create one and set
an estimation of the "mean" duration of the game plays. You can always edit the events'
duration later.

In the sports where the clock stops at each game interruption, you may have to re-
synchronize the statistics and the video after each interruption!

To import events

1. Select Import Events... from the Import/Export button located in the Events list panel.
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2. Locate and open the .csv file. The following window opens:

3. Choose the delimiters which separate each column of data in the imported file. If unsure,
experiment with the various choices remembering that more than one delimiter might be
used.

4. Decide which columns to import by ticking or unticking the headings at the top of each
column.

5. Select which columns correspond to Position and Duration. Remember that these two
categories are essential for identifying and creating events.

6. Click on Next

Synchronizing events and video

It is very likely that the first event in the list is not synchronized to the video. Use the playback
function of the preview player to move the video to the position which approximately matches
the first event. All following events are time shifted accordingly.

If you used the Pause recording function during recording, you may have to re-synchronize
other events further down in the list. If you plan to use the Import function, we recommend
that you do not pause recording.
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1.5 Review & edit events

Play Events mode is used to review and edit tagged events. To use play events mode you click
the Play Events button on the mode bar above the video display.

 If it is not already displayed you also need to open the Events List by clicking the Events List

button  on the views bar above the video display.

1.5.1 Selecting events from the Events List

Selecting and playing events

Single click selects the clip - use the playback controls to play it.

Double click selects and plays the clip.

Sorting events

Events may be sorted by clicking any of the category headings.

List Overlapping

Remember that events can overlap. For example, in soccer a shot at goal event will overlap
with a goalkeeping event. This button displays events that overlap with the currently selected
event.

Selecting multiple events

By selecting more than one event you can indicate which events in your events list you want to
play, edit or delete. Selecting several events is possible by the following methods:

1. Select several isolated events – hold down the control [ctrl] key on the keyboard and click
each event in turn.

2. Select a group of sequential events – click the first event in the group then hold down the
shift key and select the last event in the group.

3. Select all events – click any event and then use the keyboard shortcut ctrl + A

1.5.2 Editing the event

Editing values

An event's value information can be added to or changed in 2 ways:

1. Using the tagging panel – when an event is selected in the events list, its values may be
changed using the tagging panel's value controls.

2. Clicking the right mouse button while pointing at the value to be changed and choosing
Edit from the quick menu. A value may be typed or selected from a list.
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To edit an event's position and duration

1. Activate the Maximize play range function in the Timeline.

2. Click on an event in the Events list. The event corresponds to the play range; the pale blue
area between the Cue In and Cue Out point.

Drag the Cue In and Cue Out points to modify the event's position and duration.

1.5.3 Hiding unused categories

The Events List continues to display categories used by previous tagging projects even if they
are not used by the current tagging session. The categories may be removed from the events
list by:

1. Right clicking any column heading, and

2. Choosing Show available columns from the quick menu that appears.

1.6 Search to retrieve specific events

Tagging will typically result in a long list of events. Locating particular events or analyzing their
frequency using the events list alone would be a difficult task. There are three methods for
searching for events:

Table -  a useful and compact representation of your events used to:

Retrieve specific group of events quickly, e.g. all the passes of a player

Create competition statistics e.g. number of incomplete passes of a team

Search -  events can be retrieved by value, category or keyword:

Extremely versatile search that can be as broad or as specific as you require.

Favorites -  your searches can be stored as a favorite

This allows your most common searches to be easily repeated.
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1.6.1 Using Searches

1. Open the video clip(s) you wish to search for events and tag them if necessary.

2. Click the Search Events tab at the bottom of the Tagging Project Panel.

3. Choose the search type to be used from the Table, Search, Favorites buttons at the top of
this panel.

Table search

1. Choose a table category. Here the category headings appearing in the rows of the table are
selected. This will display a list of all tables matching this category.

2. Select a table from the list. This displays the chosen table. In the basketball example below
'set actions v home team' has been chosen after selecting the 'set actions'  table category.

3. Clicking each figure and heading of the resulting table filters the events list to match your
selection

Search events

The search events section of the tagging project panel is show below:
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Search events will let you:

1. Search for any text in any value.

2. Select categories in which to search.

3. Specify values to find in the chosen categories by clicking the 'this value' links.

Searches using more than one category can be linked by and or keywords. "And" means that
for events to be displayed the value(s) in both categories must be found. "Or" means that
events will be displayed if the value(s) are found in either category.

1.6.2 Adding Favorite Searches

Adding Favorites

1. Create a search using Search events.

2. Click the Add button at the top of the panel .

Naming Favorites

The saved search will appear in the favorites list which is displayed when you click the favorites
button. New favorites are given a default name of "Query". To rename;

1. Select favorite and then click on it once again. The name will enter an editing mode.
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2. Typing a new name then press the enter key to complete the operation.

Recalling a favorite search

Click on the search you wish to repeat.

Deleting

Favorites are deleted by clicking the Remove button at the top of the panel.

1.6.3 Undo searches

Searches reduce the event list to displaying only search results. To see all events, click the
show all button at the top of the events list.

1.7 Exporting events

There are three different "export" options that can be accessed in the toolbar of the Events list:

1. Publish Events - a selection of events can be directly burned to CD or published as new
video clips. Insert the newly created video clips into a video editing software to create
motivation clips with transition effects and music. You also have the option of creating
Playlists of video clips of events. They can be loaded in the Tray and are ready to be
presented to your team. The presenter only needs to know the basic VCR playback
functions of the Player.

2. Export Events -  export a selection of events in a .csv file that could be used as a backup
copy of your tagging work.

Such a file can be imported later and re-synchronized to the video (see Importing events).
Or, you can open a .csv file in a spread sheet application (such as MS Excel) to draw
statistics.

3. Storyboard - selected events can be "transferred" to the Analyzer module and analyzed as
any other Storyboard item.

See  An analyzer project - the Storyboard in the Analyze performance chapter to learn
more. Each selected event creates a new storyboard item.

1.7.1 Exporting events

To export events:

1. Select events in the Events list and click the Export Events... option of the Import/Export
button

 .

2. Select the range of events to be exported.
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Your selection is exported in a CSV files which can be opened in spreadsheets and databases to
draw statistics and create graphs. You can also use such files as backup copy of your tagging
work.

1.7.2 Publishing events

Select events in the Events list and click the Publish button. These can be published to three
different destinations, as illustrated below:

1. My Computer - a new video clip of each selected event is created. Video quality can be left
unchanged (applies to .wmv, .avi and .mpeg video settings).

In the last step of the wizard, you have the option of generating a Playlist of the newly
created video clips. Select a destination directory, enter the name of the Playlist and click
on the Save button. A Playlist with the file extension *.playerproject is created. It contains
links to the new video clips. You can open this Playlist in the Tray and present it to your
team using the Player.

2. Recordable CD or DVD or Enhanced Recordable CD or DVD - selected clips are burned on a
CD. Read Sharing video files in the Video Library chapter to learn about these two
destinations.
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1.7.3 Storyboard

To export events to the Storyboard:

1. Select events in the Events list and click the Storyboard button.

 .

2. Select the range of events to be exported.

Each event is added to the current contents of the Storyboard.

Dartfish does not automatically switch to the Analyzer module but instead allows you to
continue working with Tagging.  Potentially you can export further events to the
Storyboard; these will be added to previously exported events.
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